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BAB III 

METODELOGI PERHITUNGAN 

 

3.1.Diagram Alur Perencanaan  

Metoda penyelesaian ini tergambar dalam bagan alir dibawah ini: 

1. Plat lantai dan atap 1. Balok

2. Tangga 2. Kolom

Tidak

Ya

Output Gaya Dalam Akibat 

Gravitasi dan Gempa

Analisa Struktur 

SAP 2000 Ver.14

Perhitungan penulangan Perhitungan penulangan 

Selesai

Syarat Terpenuhi

Penyusunan Gambar Laporan 

dan Kesimpulan

Mulai

Pengumpulan Data dan Studi 

Literatur

Pleliminary design

Pemodelan Struktur

Beban GravitasiBeban Gempa

Dimensi Diperbesar

 

Gambar 3.1. Bagan Alir Tahapan Perencanaan 
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3.2.Perencanaan Portal 

Portal yang direncanakan pada Gedung Rumah Sakit TMC Provinsi 

Jawa Barat adalah portal terbuka. Perhitungan konstruksi portal diwakili 

oleh dua portal yang mempunyai bentang cukup panjang dan menahan 

beban yang paling besar. Hal ini dilakukan untuk mempermudah proses 

perhitungan yang dilakukan secara 2 dimensi.  

3.2.1. Pembebanan Portal  

a. Beban merata  

Beban diatas ditransfer ke setiap tepi, untuk bentang yang lebih 

pendek beban akan menjadi beban segitiga. Bentang yang lebih 

panjang akan berupa beban trapesium. Hal tersebut berdasarkan 

teori amplop dimana beban segitiga dan beban trapesium 

tersebut diubah menjadi beban equivalen. Sehingga beban 

menjadi merata sepanjang bentang balok. 

 

Gambar 3.2. Penyaluran beban metode amplop 

Secara garis besar pembebanan untuk portal adalah sebagai 

berikut : 

 

Gambar 3.3. Distribusi q equivalen trapesium 



31 
 

Bayu Widiantoro, 2017 
PERENCANAAN STRUKTUR PORTAL BETON BERTULANG (STUDY KASUS : GEDUNG RUMAH SAKIT 
TASIK MEDICAL CENTER) TASIKMALAYA 
Universitas Pendidikan Indonesia | repository.upi.edu | perpustakaan.upi.edu 

qequivalen trapesium   =  


























 22

2 3

1

2

1
lxly

ly

lx
q  

 

Gambar 3.4. Distribusi q equivalen segitiga 

qequivalen segitiga lxq
3

1
 

Keterangan: 

q = Beban yang ditahan   

Lx = Bentang pendek  

Ly  = Bentang panjang  

 

b. Beban Terpusat 

Bisa terjadi diakibatkan dari beban balok anak. Pada 

perhitungan portal ini terjadi karena penyaluran beban pelat. 

 

Gambar 3.5. Penyaluran beban terpusat pada join 
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3.2.2. Beban Gravitasi 

Pembebanan pelat atap terdiri dari: 

a. Beban hidup (LL)    

b. Beban mati (DL)       

1) Berat sendiri pelat   

2) Berat Gyp Tile + penggantung, ME 

3) Berat genangan air hujan finishing aspal  

4) Berat genangan air hujan 5 cm     

5) Berat lapisan aspal 1 cm   

Pembebanan pelat lantai terdiri dari: 

a. Beban hidup (LL) 

b. Beban mati (DL)       

1) Berat sendiri pelat  

2) Berat Gyp Tile + penggantung,  

3) Beban finishing lantai keramik : 

4) Berat adukan setebal 0,015  

5) Berat penutup lantai :    

 

3.2.3. Beban Gempa 

Untuk perhitungan beban gempa menggunakan metode statik 

ekivalen dengan mengacu pada Tata Cara Perencanaan Ketahanan 

Gempa Untuk Bangunan Gedung SNI 1726–2012. Dengan 

menggunakan persamaan berikut: 

  VCF vxx .  

 dimana 
k

ii

k

ii
vx

hW

hW
C


  

Keterangan: 

Cvx = Faktor distribusi vertikal 
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V = Gaya lateral desain total atau geer didasar struktur, 

dinyatakan dalam kilonewton (kN) 

w = Bagian berat seismic efektif total struktur  

h = Tinggi dari dasar 

k = eksponen yang terkait dengan perioda struktur 

 Berdasarkan rumus tersebut maka tahapan perhitungan 

beban gempa antara lain sebagai berikut: 

a. Klasifikasi Situs 

Dalam perumusan kriteria desain seismik suatu bangunan 

dipermukaan tanah atau penentuan amplifikasi besaran 

percepatan gempa puncak dari batuan dasar ke permukaan tanah 

untuk suatu situs, maka situs tersebut harus diklasifikasikan 

terlenih dahulu. Profil tanah harus disesuaikan berdasarkan tabel 

berikut: 

Tabel 3.1. Klasifikasi situs tanah 

 

Sumber: SNI 1726-2012 
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b. Wilayah Gempa dan Spektrum Respons 

Untuk penentuan respons spektral percepatan gempa 

MCER di permukaan tanah, diperlukan suatu faktor amplifikasi 

seismik pada perioda 0,2 detik dan perioda 1 detik. Faktor 

amplifikasi meliputi faktor amplifikasi getaran terkait 

percepatan pada getaran perioda pendek (Fa) dan faktor 

amplifikasi terkait percepatan yang mewakili getaran perioda 1 

detik (Fv). Parameter spektrum respons percepatan pada perioda 

pendek (SMS) dan perioda 1 detik (SM1) yang disesuaikan dengan 

pengaruh klasifikasi situs.  

Dalam laporan ini penentuan wilayah gempa dan 

spektrum respons ditentukan dengan bantuan aplikasi online 

desain spektra Indonesia 2011 dari Kementerian Pembangunan 

Umum. 

Berikut langkah-langkah menentukan grafik spektrum respon 

gempa menggunakan aplikasi tersebut:  

1) Halaman awal  

Masukan pada web browser alamat sebagai berikut 

http://puskim.pu.go.id/Aplikasi/desain_spektra_indonesia

_2011 sehingga akan muncul halaman awal seperti pada 

gambar  

 

Gambar 3.6. halaman awal desain spketra Indonesia 2011 

http://puskim.pu.go.id/Aplikasi/desain_spektra_indonesia_2011
http://puskim.pu.go.id/Aplikasi/desain_spektra_indonesia_2011
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2) Tentukan jenis input  

Jenis input bisa dilakukan dengan 2 cara yaitu berdasarkan 

koordinat (bisa dengan cara meng-klik wilayah peta yang 

disediakan) atau nama kota. Untuk penentuan pada tugas 

akhir ini dilakukan dengan menggunakan koordinat. 

 

Gambar 3.7. Memilih jenis input data 

3) Pilih wilayah yang akan dianalisis 

 

Gambar 3.8. input data 

4) Klik hitung untuk menampilkan hasil 

Maka akan muncul grafik respons spektrum seperti pada 

gambar.  

 

Gambar 3.9. Hasil analisis 

5) Pilih tanah yang dipakai  
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Pilih tanah yang akan dipakai sesuai dengan klasifikasi situs 

yang telah ditentukan sebelumnya 

 

Gambar 3.10. Hasil analisis dipilih sesuai kelas situs 

6) Salin tabel yang sudah teranalisis dari aplikasi 

Untuk tabel tersebut data yang dipakai bisa disalin kedalam 

bentuk file excel. 

 

Gambar 3.11. Output excel hasil analisis grafik spectra 

 

c. Faktor Keutamaan dan Kategori Resiko Struktur Bangunan 

Untuk berbagai kategori resiko struktur bangunan gedung 

dan non gedung dikategorikan terhadap 4 kategori resiko sesuai 

Tabel 3.2 kategori struktur bangunan berpengaruh terhadap besar 

faktor keutamaan gempa bangunan tersebut. 
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Tabel 3.2. Kategori resiko bangunan gedung dan non gedung 

untuk beban gempa 

Jenis pemanfaatan 
Kategori 

resiko 

Gedung dan non gedung yang memiliki risiko rendah terhadap jiwa 

manusia pada saat terjadi kegagalan, termasuk, tapi tidak dibatasi untuk, 

antara lain: 

 

  - Fasilitas pertanian, perkebunan, perternakan, dan perikanan 

  - Fasilitas sementara 

  - Gudang penyimpanan 

  - Rumah jaga dan struktur kecil lainnya 

I 

Semua gedung dan struktur lain, kecuali yang termasuk dalam kategori 

risiko I,III,IV, termasuk, tapi tidak dibatasi untuk: 

  - Perumahan 

  - Rumah toko dan rumah kantor 

  - Pasar 

  - Gedung perkantoran 

  - Gedung apartemen/ rumah susun 

  - Pusat perbelanjaan/ mall 

  - Bangunan industri 

  - Fasilitas manufaktur 

  - Pabrik 

II 

Gedung dan non gedung yang memiliki risiko tinggi terhadap jiwa 

manusia pada saat terjadi kegagalan, termasuk, tapi tidak dibatasi untuk: 

- Bioskop 

- Gedung pertemuan 

- Stadion 

- Fasilitas kesehatan yang tidak memiliki unit bedah dan unit 

gawat       darurat 

- Fasilitas penitipan anak 

- Penjara 

- Bangunan untuk orang jompo 

Gedung dan non gedung, tidak termasuk kedalam kategori risiko IV, 

yang memiliki potensi untuk menyebabkan dampak ekonomi yang besar 

dan/atau gangguan massal terhadap kehidupan masyarakat sehari-hari 

bila terjadi kegagalan, termasuk, tapi tidak dibatasi untuk 

- Pusat pembangkit listrik biasa 

- Fasilitas penanganan air 

- Fasilitas penanganan limbah 

- Pusat telekomunikasi 

Gedung dan non gedung yang tidak termasuk dalam kategori risiko IV, 

(termasuk, tetapi tidak dibatasi untuk fasilitas manufaktur, proses, 

penanganan, penyimpanan, penggunaan atau tempat pembuangan bahan 

bakar berbahaya, bahan kimia berbahaya, limbah berbahaya, atau bahan 

yang mudah meledak) yang mengandung bahan beracun atau peledak di 

mana jumlah kandungan bahannya melebihi nilai batas yang disyaratkan 

oleh instansi yang berwenang dan cukup menimbulkan bahaya bagi 

masyarakat jika terjadi kebocoran. 

III 
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Tabel 3.2. Kategori resiko bangunan gedung dan non gedung 

untuk beban gempa (lanjutan) 

Jenis pemanfaatan 
Kategori 

resiko 

Gedung dan non gedung yang ditunjukkan sebagai fasilitas yang penting, 

termasuk, tetapi tidak dibatasi untuk: 

- Bangunan-bangunan monumental 

- Gedung sekolah dan fasilitas pendidikan 

- Rumah sakit dan fasilitas kesehatan lainnya yang memiliki fasilitas 

bedah dan unit gawat darurat 

- Fasilitas pemadam kebakaran, ambulans, dan kantor polisi, serta 

garasi kendaraan darurat 

- Tempat perlindungan terhadap gempa bumi, angin badai, dan tempat 

perlindungan darurat lainnya 

- Fasilitas kesiapan darurat, komunikasi, pusat operasi dan fasilitas 

lainnya untuk tanggap darurat 

- Pusat pembangkit energi dan fasilitas publik lainnya yang 

dibutuhkan pada saat keadaan darurat 

- Struktur tambahan (termasuk menara telekomunikasi, tangki 

penyimpanan bahan bakar, menara pendingin, struktur stasiun listrik, 

tangki air pemadam kebakaran atau struktur rumah atau struktur 

pendukung air atau material atau peralatan pemadam kebakaran ) yang 

disyaratkan untuk beroperasi pada saat keadaan darurat  

Gedung dan non gedung yang dibutuhkan untuk mempertahankan fungsi 

struktur bangunan lain yang masuk ke dalam kategori risiko IV. 

IV 

Sumber: SNI 1726-2012 

Tabel 3.3. Faktor keutamaan gempa 

 

Sumber: SNI 1726-2012 

d. Kategori Desain Seismik 

Berdasarkan nilai SDS dan SD1, maka kategori desain 

seismik dapat ditentukan sesuai tabel 3.4. dan 3.5. 
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Tabel 3.4. Kategori desain seismik berdasarkan parameter 

respons percepatan pada perioda pendek 

 

Sumber: SNI 1726-2012 

Tabel 3.5. Kategori desain seismik berdasarkan parameter 

respons percepatan pada perioda pendek 

 

Sumber: SNI 1726-2012 

Untuk memlilih syarat spesifik sistem tabel 3.6. sesuai dengan  

kategori seismik 

Tabel 3.6. Syarat spesifik sistem 

 

Sumber: SNI 1726-2012 

Keterangan: 

SRPMB : Struktur Rangka Pemikul Momen Biasa 

SRPMM : Struktur Rangka Pemikul Momen Menengah 

SRPMK : Struktur Rangka Pemikul Momen Khusus 

 



40 
 

Bayu Widiantoro, 2017 
PERENCANAAN STRUKTUR PORTAL BETON BERTULANG (STUDY KASUS : GEDUNG RUMAH SAKIT 
TASIK MEDICAL CENTER) TASIKMALAYA 
Universitas Pendidikan Indonesia | repository.upi.edu | perpustakaan.upi.edu 

Setelah menentukan syarat spesifik sistem maka didapat nilai R, 

Cd, dan Ω0 . 

Tabel 3.7. Faktor nilai R, Cd, dan Ω0 untuk sistem penahan gaya gempa. 

 

Sumber: SNI 1726-2012 

e. Perioda Fundamental  

Perioda fundamental pendekatan Ta , dalam detik dengan 

persamaan SNI 1726-2012 pasal 7.8.2.1 berikut: 

x

nta hCT .  

Keterangan: 

nh = ketinggian struktur (m) diatas dasar sampai tingkat tinggi 

struktur dan koefisien tC dan x ditentukan dari tabel 3.8. 
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Tabel 3.8. Nilai parameter periode pendekatan tC dan x  

 

Sumber: SNI 1726-2012 

f. Gaya Lateral Ekivalen 

1) koefisien respons seismik 

geser dasar seismik V, dalam arah yang ditetapkan harus 

ditentukan sesuai dengan persamaan berikut: 

V  = Cs.W 

Cs harus ditentukan dengan persamaan 

Cs = 












e

DS

I

R

S
 

Nilai Cs yang dihitung sesuai persamaan diatas tidak boleh 

melebihi: 

Csmax = 












e

DS

I

R
T

S
 

Cs harus tidak kurang dari: 

Csmin = eDS IS044,0  

Keterangan: 

Cs = Koefisien respons seismik 

W = Berat seismic efektif 

SDS = Parameter percepatan spektrum respons dalam periode 

pendek 
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SDI = Parameter percepatan spektrum respons dalam periode 

0,1 destik 

Ie = Faktor keutamaan gempa 

T = Periode fundamental struktur 

2) Distribusi vertikal gaya gempa  

Gaya gempa lateral yang timbul disemua tingkat harus 

ditentukan dari persamaan berikut: 

VCF vxx .  

dan 

k

ii

k

ii
vx

hW

hW
C


  

Keterangan: 

Cvx = Faktor distribusi vertikal 

V = Gaya lateral desain total atau geer didasar struktur, 

dinyatakan dalam kilonewton (kN) 

w = Bagian berat seismic efektif total struktur  

h = Tinggi dari dasar 

k = eksponen yang terkait dengan perioda struktur sebagai 

berikut: 

untuk struktur yang mempunyai perioda sebesar 0,5 

detik atau kurang, k = 1 

untuk struktur yang mempunyai perioda sebesar 2,5 

detik atau lebih, k = 2 

untuk struktur yang mempunyai perioda antara 0,5 dan 

2,5 detik, k harus sebesar 2 atau harus ditentukan 

dengan interpolasi linier antara 1 dan 2. 
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3.3.Langkah-langkah Penggunaan SAP 2000 v. 14 

3.3.1.Tahapan Analisis. 

a. Memulai aplikasi SAP 2000 v. 14 

b. Memilih model struktur.  

1) Pilih Input Unit KN,m,C  

2) Isikan Informasi Project yang sedang dikerjakan mengklik 

Modify/Show Info pada sudut kanan atas, setelah itu klik OK.  

3) Pilih 2D frames > Klik OK.  

c. Penentuan sifat-sifat material dan penampang (material properties 

and section).  

1). Mendefinisikan Material Data Beton  

2). Klik Define > Materials  

3). Pada kotak dialog define material, klik Add New Material  

pada kotak dialog Material property data  

d. Mendefinisikan beban dan kombinasi pembebanan (Load patern 

dan Load combinations)  

e. Menentukan kondisi perletakan  

f. Memasukan data-data pembebanan pada struktur  

g. Asumsi-asumsi dan analisis ( analysis options )  

1). Dari Menu Utama, Klik Analyze > Set Analysis Option.  

2). Klik pada Model Plane Frame > klik OK.  

3). Dari Menu Utama, Klik Analyze > Run Analysis atau tekan 

tombol F5 pada keyboard. 

4). Klik Run Now pada new window Select Load Cases To Run.  

 

Gambar 3.12. Hasil Running SAP 2000 
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h. Menampilkan gaya-gaya dalam struktur. 

1). Dari Menu Utama, Klik Display > Show Forces/Stress > 

Frame/Cable.  

2). Pilih Component yang akan ditinjau > klik OK.  

 

Gambar 3.13. Momen yang terjadi pada struktur 

3.3.2.Output Analisis Gaya 

a. Melihat hasil dalam bentuk tabel 

1) Dari main menu, klik Display > Show Tables  

2) Pilih Analisis Results yang ingin ditampilkan dalam tabel data.  

3) Pada new window, klik File > Export all tables > To Excel 

4) Save file yang sudah di export dalam Excel  

 

 

Gambar 3.14. Hasil dalam bentuk tabel excel 

b. Membuat laporan hasil analisis dan desain dalam bentuk file word.  

Dari main menu klik File > Create Report.  
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Gambar 3.15. . Laporan hasil analisis 

3.4.Perencanaan Pelat 

3.4.1.Tentukan Panjang Bentang 

Sebagaimana dikemukakan oleh Kusuma G dkk. (1993, hlm. 73) 

menggunakan persamaan : 

 

Gambar 3.16. Penentuan panjang pelat 

Ln = L + (2 . 0,5 . b) 

Dimana : 

Ln = panjang bentang bersih 

L = panjang bentang  

b = lebar balok 

3.4.2.Menentukan Tebal Pelat 

Berdasarkan SNI 03-2847-2002 (2002, hlm. 66) tebal pelat minimum 

dengan balok yang menghubungkan tumpuan pada semua sisinya 

harus memenuhui ketentuan sebagai berikut :  

hmin=
C

fy
Ln

936

)
1500

8,0.(




  

dan ≥ 90 mm 
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Dimana : 

h = ketebalan pelat 

Ln  = panjang bentang 

fy = mutu baja tulangan 

C = ly/lx 

3.4.3.Menghitung Beban 

Sebagaimana dikemukakan oleh Kusuma G dkk. (1993, hlm. 75). 

Setelah menentukan bentang dan tebal pelat, kemudian beban-beban 

dihitung sebagai berikut : 

Wu = 1,2 DL + 1,6 LL 

Dimana : 

Wu = Kuat perlu 

DL = Beban mati 

LL = Beban hidup 

3.4.4.Tentukan Momen yang Menentukan 

Sebagaimana dikemukakan oleh Kusuma G dkk. (1993, hlm. 77). 

Untuk pelat ditumpu bebas berlaku : 

Mu = 1/8 Wu l
2
 

Dan untuk momen jepit takterduga berlaku : 

Mu = 1/24 Wu l
2
 

Dimana : 

Mu = momen ultimit 

Wu = kuat perlu 

l =  panjang bentang 

Atau Wahyudi L & Rahim S. (1997, hlm. 121). Momen yang 

mentukan per meter lebar dalam jalur tengah pada pelat dua arah 

akibat beban terbagi rata. 
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Tabel 3.9. Tipe Momen Pelat  

 

3.4.5.Menghitung dan Memilih Tulangan 

1) Menghitung Tinggi Efektif 

Sebagaimana dikemukakan oleh Kusuma G dkk. (1993, hlm. 78). 

Menghitung tinggi efektif sebagai berikut : 

d = h – p – ½ Ø 

Dimana : 

d = tinggi efektif 

h = tebal plat 

p = selimut beton 

Ø = diameter tulangan 

2) Menghitung ρ 

Sebagaimana dikemukakan oleh Kusuma G dkk. (1993, hlm. 78). 

Menghitung ρ sebagai berikut : 

 ρb  = 








 fyfy

fc

600

600
.

'.85,0
  

 ρ maks = 0,75 . ρb 

 ρmin  =
fy

4,1
 

Syarat = ρmin  < ρ < ρmaks 
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Dimana : 

fc’ = kuat tekan beton  

fy = kuat leleh baja 

β = 0,85 

3) Menghitung Luas Tulangan (As) 

Sebagaimana dikemukakan oleh Kusuma G dkk. (1993, hlm. 

K = 
2.. db

Mu


 

 ρ perlu = 














'.85,0

.2
11

'.85,0

fc

k

fy

fc
 

Dimana : 

Mu = Momen ultimate 

d = tinggi efektif 

b = 1 meter 

Ø = 0,8 reduksi 

fc’ = kuat tekan beton  

fy = kuat leleh baja 

 

Menghitung luas tulangan (As) sebagai berikut : 

As = ρ. b. d 

Dimana : 

As = luas tulangan  

b = lebar plat 

d = tinggi efektif 

Menghitung jarak tulangan dapat ditentukan sebagaimana  

menggunakan dikemukakan oleh Kusuma G dkk. (1993, hlm. 

15).  
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Tabel 3.10. Diameter tulangan dalam mm
2
 per meter lebar pelat 

 

3.4.6. Bagan Alir Perencanaan Pelat  

Tebal Pelat dan 

Tulangan Memadai

Pilih Tulangan

Hitung Tulangan ρ > ρmaks

S > Smaks
Periksa Lebar Retak 

Secara Memeriksa Lebar 

Jaringan

Tentukan Panjang Bentang      

Tentukan Tebal Pelat

Hitung Beban

Tentukan Momen yang 

Menentukan

S ≤ ρ ≤ Smaks 

ρmin ≤ ρ ≤ ρmaks 

 

Sumber: Kusuma G. (1993) 

Gambar 3.17. Bagan Alir perencanaan pelat. 
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3.5.Tangga 

Menurut Djojowirono (1984) dalam Asroni A (2010, hal. 235) 

Penentuan sudut kemiringan tangga bergantung kepada fungsi/ 

keperluan tangga yang akan dibangun. Sebagai pedoman dapat 

diambil ketentuan sebagai berikut : 

a Untuk tangga mobil masuk garasi, diambil sudut maksimal 

12,5˚ atau dengan kemiringan 1 : 4,5 

b Untuk tangga di luar bangunan, diamibil sudut 20˚ atau 

kemiringan 1:2,75 

c Untuk tangga perumahan dan gedung pada umumnya, 

diambil sudut kemiringan 30˚ sampai 35˚, atau kemiringan 1 : 

1,7 sampai 1: 1,4. 

d Untuk tangga dengan sudut sama atau lebih besar dari 41˚, 

disebut tagga curam, biasanya digunakan untuk basement, 

menara atau tandon air. 

Dalam Asroni A (2010, hal. 238) agar tangga dapat 

digunakan/dilalui dengan mudah, nyaman dan tidak melelahkan, 

maka ukuran anak tangga perlu diperhitungkan dengan mengingt 

beberapa pertimbangan berikut : 

a Jarak satu langkah orang berjalan, berkisar antara 61 cm 

sampai dengan 65 cm. 

b Pada saat orang berjalan, tenaga untuk mengangkat kaki 

diperlukan dua kali lipat daripada tenaga untuk memajukan 

kaki. 

c Semakin kecil sudut kemiringan tangga, semakin mudah 

untuk dilalui/didaki. 

Berdasarkan pertimbangan diatas, maka ukuran anak tangga 

dapat ditentukan dengan persamaan berikut : 

2 Optrade + Antrade = 61 sampai 65 cm 

 



51 
 

Bayu Widiantoro, 2017 
PERENCANAAN STRUKTUR PORTAL BETON BERTULANG (STUDY KASUS : GEDUNG RUMAH SAKIT 
TASIK MEDICAL CENTER) TASIKMALAYA 
Universitas Pendidikan Indonesia | repository.upi.edu | perpustakaan.upi.edu 

Dimana : 

Optrade = tinggi bidang tanjakan atau tinggi anak tangga 

Antrade  = lebar bidang tanjakan atau lebar anak tangga 

 

Gambar 3.18. Ukuran Anak Tangga 

3.6.Perencanaan Struktur Balok 

3.6.1.Tentukan Syarat-Syarat Batas 

Kusuma G dkk (1993, hal. 102) pada persyaratan 

tulangan balok disamping beban-beban pada balok ternyata 

ukuran dan syarat-syarat tumpuan pun perlu diketahui. 

Tumpuan akan dianggap kaku, yaitu tidak dapat berdeformasi, 

sehingga hanya tiga syarat-syarat tumpuan yang 

dipertimbangkan, yaitu: 

a Tumpuan bebas (sederhana), balok yang ditumpu 

bebas dapat mengalami perputaran sudut pada 

perletakan. 

b Tumpuan terjepit penuh, balok yang ditumpu tidak 

bisa berotasi. 

c Tumpuan terjepit sebagian (pasrsial), suatu keadaan 

diantara dua situasi tumpuan bebas dan terjepit yang 

memungkinkan tumpuan ini dapat sedikit berotasi. 
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3.6.2.Penentuan Panjang Bentang 

Kusuma G dkk (1993, hal.102) seperti halnya konstruksi 

plat, pada balok berlaku pula panjang bentang teoritis l harus 

dianggap sama dengan bentang bersih L ditambah dengan 

setengah panjang perletakan yang telah ditetapkan. Untuk 

bentang teoritis harus ditntukan sebagai bentang bersih L 

ditambah tinggi balok 

3.6.3.Tentukan Dimensi Balok 

Kusuma G dkk (1993, hal.104) balok didiemnsikan 

dengan persyaratan tinggi minimum akan menghasilkan 

persentase penulangan tinggi atau dapat menimbulkan masalah 

berkaitan dengan penampungan tegangan geser akibat gaya 

lintang. Ukuran balok cukup diperkirakan dengan: 

 hmin  = l.
10

1
 

 hmax  = l.
15

1
 

 bmin  = h.
2

1
 

 bmax  = h.
3

2
 

Dimana: 

h = tinggi balok 

b = lebar balok 

l = panjang bentang 

3.6.4.Menghitung Beban-Beban 

Setelah menentukan dimensi balok, kemudian beban-

beban (beban gempa dan gravitasi) dihitung kuat perlu dengan 

kombinasi sebagai berikut: 

 U = 1,4 D 
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 U = 1,2 D + 1,6 L  

 U = 1,2 D + 1,0 L + 1,0 E 

 U = 1,2 D + 1,0 L - 1,0 E 

 

Dimana: 

U = Kuat perlu 

D = Beban mati 

L = Beban hidup 

E = Beban gempa 

3.6.5.Tentukan Momen yang Menentukan 

Untuk mendapatkan gaya–gaya dalam didapat dengan 

menggunakan bantuan program komputer SAP2000 Versi 14 

3.6.6.Hitung Tulangan yang Menentukan 

Berdasarkan Asroni A (2010, hal.39) Beban yang 

bekerja pada balok biasanya berupa beban lentur, beban geser 

maupun torsi (momen puntir), sehingga perlu baja tulangan 

untuk menahan beban-beban tersebut. Tulangan ini berupa 

tulangan memanjang (longitudinal) yang berfungsi menahan 

beban lentur, serta tulangan geser (begel) yang berfungsi 

menahan beban geser dan torsi). 

a. Tulangan Longitudinal Balok Tunggal 

1) Menghitung jarak antara titik berat tulangan tarik dan tepi 

serat beton tarik (ds), sebagai berikut : 

ds = p + Ø tulangan geser + D tulangan utama / 2 

Dimana: 

p = selimut beton 
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Ø = diamter tulangan ulir 

D = diamter tulangan polos 

2) Menghitung tinggi efektif penampang balok (d), sebagai 

berikut : 

d = h – ds 

 

Dimana: 

h = tinggi balok 

ds = jarak antara titik berat tulangan tarik dan tepi 

serat beton tarik 

3) Menghitung faktor momen pikul (K), berikut : 

 Kmaks =
2

11

)600(

).225600'.(..5,382

fy

fyfc



 
 

 K  = 2.. db

Mu


 

Jika, K < Kmaks, maka digunakan tulangan tunggal 

Dimana: 

β1 = 0,85 

fc = mutu beton 

fy = mutu baja 

b = lebar balok  

d = tinggi efektif 

  = 0,8 

4) Menenghitung tinggi balok tegangan tekan beton persegi 

ekuivalen (a), berikut : 

a  = d
fc

K
.

'.85,0

2
11














  

Dimana: 

d = tinggi efektif 

k = faktor momen pikul 
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fc = mutu beton 

5) Menghitung jumlah tulangan maksimal per baris (m), 

sebagai berikut : 

m = 1
utamatulangan 

.2






Snt

dsb


 

 

Dimana: 

b = lebar balok  

ds = jarak antara titik berat tulangan tarik dan tepi 

serat beton 

Sn = jarak bersih antar tulangan pada arah mendatar, 

dengan syarat dari Ø dan lebih besar dari 40 

mm. Dipilih nilai yang besar 

  = diameter tulangan 

6) Menghitung luas tulangan perlu (Asu), dipilih yg terbesar 

berikut : 

 As  =
fy

bafc .'.85,0
 

 As min = 
fy

db..4,1
 

Dimana: 

fc = mutu beton 

a  = balok tegangan tekan beton persegi ekuivalen 

b  = lebar balok 

d = tinggi efektif 

fy = mutu baja 

7) Jumlah tulangan (n) yang dipakai dihitung dengan 

membagi luas tulangan perlu As terhadap luas tulangan 1 

batang, diperoleh : 
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n =
2..

4
1 D

As


 

Dimana : 

As = luas tulangan perlu 

D = diameter tulangan 

8) Kontrol : 

Mr ≥ Mu 

ɛc’ ≤ 0,003 

Dimana : 

Mu = momen ultimit 

Mr = momen rencana 

ɛc’ = regangan tekan beton 

b.Tulangan Longitudinal Balok Rangkap 

Hasil momen adalah negatif (-), berarti tulangan tarik 

berada di bagian atas dan tekan di bagian bawah. 

1) Menghitung jarak antara titik berat tulangan tarik dan 

tepi serat beton tarik (ds), sebagai berikut : 

ds = p + Ø tulangan geser + D tulangan utama / 2 

Dimana : 

p = selimut beton 

Ø = dismetr tulangan 

2) Menghitung tinggi efektif penampang balok (d), sebagai 

berikut : 

d = h – ds 

Dimana : 

h = tinggi balok 

ds = jarak antara titik berat tulangan tarik dan tepi 

serat beton tarik 

3) Menghitung faktor momen pikul (K), berikut : 
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 Kmaks =
2

11

)600(

).225600'.(..5,382

fy

fyfc



 
 

 K  = 2.. db

Mu


 

Karena K > Kmaks, maka digunakan tulangan rangkap 

Diambil K1 = 0,8 . Kmaks 

Dimana : 

β1 = 0,85 

fc = mutu beton 

fy = mutu baja 

b = lebar balok  

d = tinggi efektif 

  = 0,8 

4) Menenghitung tinggi balok tegangan tekan beton persegi 

ekuivalen (a), berikut : 

a = d
fc

K
.

'.85,0

12
11














  

Dimana : 

d = tinggi efektif 

K = faktor momen pikul 

fc = mutu beton 

5) Menghitung luas tulangan perlu As, berikut : 

A1 = 
fy

bafc .'.85,0
 

A2 = 
fydsd

dbKK

).'(

.).1( 2




 

Dimana : 

fc = mutu beton 

a  = balok tegangan tekan beton persegi ekuivalen 

b  = lebar balok 
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fy = mutu baja 

K = faktor momen pikul 

K1 = faktor momen pikul terfaktor 

d = tinggi efektif 

ds’ = jarak antara titik berat tulangan tarik dan tepi 

serat beton tekan 

6) Menghitung tulangan tarik  

As = A1 + A2 

7) Menghitung tulangan tekan  

As = A2 

8) Jumlah tulangan (n) yang dipakai dihitung dengan 

membagi luas tulangan perlu As terhadap luas tulangan 

1 batang, diperoleh : 

n =
2..

4
1 D

As


 

Dimana : 

As = luas tulangan perlu 

D = diameter tulangan 

c. Tulangan Geser Balok 

1) Menghitung gaya geser yang ditahan oleh beton (Vc), 

sebagai berikut :  

Vc = 
6

.'. dbfc
 

Dimana : 

fc = mutu beton 

b = lebar balok 

d = tinggi efektif 

2) Menghitung gaya geser yang ditahan oleh begel (Vs), 

sebagai berikut : 
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Vs = 


VcVu .
 

Dimana : 

Vu = gaya geser ultimit 

Vc = gaya geser yang ditahan oleh beton 

  = faktor reduksi geser (0,75) 

3) Menghitung gaya geser nominal (Vn), sebagai berikut : 

Vn = Vc + Vs 

 

Dimana : 

Vc = gaya geser yang ditahan oleh beton 

Vs = gaya geser yang ditahan oleh begel 

4) Menghitung gaya geser rencana (Vr), sebagai berikut : 

Vr =       

Dimana : 

  = faktor reduksi geser (0,75) 

Vn = kuat geser nominal 

5) Menghitung luas tulangan geser per meter panjang balok 

yang diperlukan (Av), dengan memilih nilai terbesar dari 

rumus berikut : 

 Av =
dfy

SVs

.

.
 

 Av = 
fy

Sbfc

.1200

..'.75
 

 Av =
3.

.

fy

Sb
 

Dimana : 

Vs = gaya geser yang ditahan oleh begel 

S = 1 meter 

fy = mutu baja 

fc  = mutu beton 



60 
 

Bayu Widiantoro, 2017 
PERENCANAAN STRUKTUR PORTAL BETON BERTULANG (STUDY KASUS : GEDUNG RUMAH SAKIT 
TASIK MEDICAL CENTER) TASIKMALAYA 
Universitas Pendidikan Indonesia | repository.upi.edu | perpustakaan.upi.edu 

d  = tinggi efektif 

b = lebar balok 

6) Menghitung spasi begel (s), sebagai berikut : 

s =
Av

Sdn ...
4

1.. 2
 

Dimana : 

n = jumlah kaki begel 

   = tinggi efektif 

S = 1 meter 

Av = luas tulangan geser per meter panjang balok 

yang diperlukan. 

3.6.7.Ukuran Balok dan Tulangan yang Memadai 

Merupakan hasil akhir dari kolom, berupa gambar yang 

menyatakan lokasi dan jumlah tulangan yang dipasang dari 

kolom yang dihitung berdasarkan pendekatan yang telah 

disebutkan serta memenuhi pesyaratan aman. 

3.6.8.Bagan Alir Perencanaan Balok 
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Ya Tidak

Tidak

Ya

Tulangan 

geser

Selesai

Tentukan Syarat-Syarat 

Batas

Menentukan Panjang 

Bentang

Menentukan Dimensi Balok

Menghitung Beban

Menghitung Momen

Menghitung Tulangan

Mulai

Ukuran Balok dan Tualangan 

Memadai

Tulangan 

Longitudinal

K < Kmaks

Tulangan 

Tunggal

Tulangan 

Rangkap

 

Gambar 3.19. Bagan Alir Perencanaan Balok 

 

3.7.Perencanaan Struktur Kolom 

3.7.1. Tentukan Syarat-Sayat Batas 

Berdasrkan Kusuma dkk (1993, hal. 174) sebuah kolom adalah 

suatu komponen struktur yang diberi beban tekan sentris atau beban 

tekan eksentris. Dilihat dari segi perecanaan ternyata sebuah kolom 

pendel (yaitu kolom yang bersendi pada setiap ujung) dari komponen 

struktur tekan merupakan contoh yang paling mudah ditinjau, karena 

pada dasarnya kolom ini hayanya mengalami gaya-gaya normal (aksi). 

Demikian kolom adalah sebuah komponen struktur yang mendapat 

beban tekan sentris. 
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 Pada struktur yang sederhana, kolom sering merupakan bagian dari 

struktur rangka. Bila pada kolom bagian atas dan bawah berhubungan 

kaku dengan komponen horizontal (balok), maka tegangan yang bekerja 

pada kolom, selain tegangan aksi mungkin juga terdiri dari tegangan 

yang disebabkan oleh momen lentur. Kini dikatakan sebuah komponen 

struktur yang mendapat beban tekan eksentis.   

3.7.2.  Tentukan Ukuran Kolom 

     Ukuran kolom menggunakan, panjang (h) dan lebar (b) kolom 

ditentukan sebagai berikut: 

   
      

  
  (     ) 

 A = b h → A = 2 b
2 

 h = 2 b 

Dimana:  

A = Luas perlu kolom 

b = lebar 

h = panjang  

Ptotal = beban ultimit yang dipikul kolom 

3.7.3. Menghitung beban-beban 

Setelah menentukan dimensi kolom, kemudian beban-beban 

(beban gempa dan gravitasi) dihitung kuat perlu dengan kombinasi 

sebagai berikut: 

 U = 1,4 D 

 U = 1,2 D + 1,6 L  

 U = 1,2 D + 1,0 L + 1,0 E 

 U = 1,2 D + 1,0 L - 1,0 E 
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Dimana: 

U = Kuat perlu 

D = Beban mati 

L = Beban hidup 

E = Beban gempa 

3.7.4. Tentukan Momen-Momen yang Menentukan 

Untuk mendapatkan gaya–gaya dalam diperoleh dengan 

menggunakan bantuan program komputer SAP2000 Versi 14. 

3.7.5. Hitung Tulangan yang Menentukan 

a. Tulangan Longitudinal Kolom 

Untuk perencanaan tulangan longitudinal kolom bersengkang 

dilaksanakan dengan langkah berikut: 

1) Dihitung nilai ac dan ab dengan persamaan: 

ac = 
bfc

Pu

'..85,0.
 

ab =    
fy

d

600

..600 1  

2) Nilai ac dan ab dibandingkan, sehingga diperoleh 2 kondisi 

penampang kolom berikut: 

a) Jika ac > ab penampang kolom pada kondisi beton tekan 

menentukan. 

Pada kondisi ini dihitung ab1 dan ab2 dengan persamaan: 

 ab1 = 
fy

d

600

..600 1
 

 ab2 =    d.1  

Serta ditetapkan nilai   = 0,65  

Kemudian dilanjutkan langkah ke c. 
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b) Jika ac < ab penampang kolom pada kondisi tulangan tarik 

menetukan. 

Pada kondisi ini dihitung at1 dan at2 dengan persamaan: 

 at1 = 
fy

ds

600

'..600 1
 

 at2 =    '.1 ds  

serta ditetapkan nilai   dengan persamaan: 

 PuØ = nbP.  

 PuØ = hbfc .'..10,0  

Jika Pu ≥ PuØ , maka nilai Ø  = 0,65 

Jika Pu < PuØ , maka nilai Ø  = 0,8 – 0,15. Pu/ PuØ 

Kemudian dilanjutkan langkah ke d. 

3) Untuk penampang kolom pada kondisi beton tekan menentukan, 

masih dibagi lagi menjadi 3 kondisi yaitu: 

a) Jika ac > ab1, maka termasuk kondisi I: beton tekan menetukan 

dengan semua tulangan tekan sudah leleh, atau dianggap 

kolom menerima beban sentris (P0), dan dihitung tulangan A1 

dan A2 dengan persamaan: 

A1 = A2 = 
)'.85,0.(2

.'..85,0/.25,1

fcfy

hbfcPu




 

b) Jika ab1 > ac > ab2, maka termasuk kondisi II: beton tekan 

menentukan dengan tulangan tekan kiri belum leleh. Proses 

hitungan dilaksanakan sebagai berikut: 

 Dihitung ap1, R1, R2, dan R3,  dengan persamaan: 

 ap1 = 
)'.85,0.(2

).2).(600(

fcfy

dhfy s




 

 R1 = ab + ap1 + h 

 R2 = 2.ab. (h-ds) + ac . (ap1 + 2.e) 
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 R3 = ab . ac .(2.e – 2.ds + h) 

 Dihitung nilai a dengan cara coba-coba dengan 

persamaan: 

 a
3 

+ R1.a
2
 + R2.a

 
– R3 = 0 

 dengan syarat: ab1 > a > ab2 

 Dihitung tulangan A1 dan A2 dengan persamaan: 

A1 = A2 = 
dafy

bafcPa u

..600).600(

).'..85,0/.(

1






 

c) Jika ab2 > ac > ab, maka termasuk kondisi III: beton tekan 

menentukan dengan tulangan tarik kiri belum leleh. Proses 

hitungan dilaksanakan sebagai berikut: 

 Dihitung ap2, R4, R5, dan R6,  dengan persamaan: 

 ap2 = 
fy

ddfy s





600

.1200..2
 

 R4 = ab + ap2 

 R3 = 2.ab. d + ac . (2.e – h + ap2) 

 R6 = ab . ac .(2.d + 2.e - h) 

 Dihitung nilai a dengan cara coba-coba dengan 

persamaan: 

 a
3 

+ R4.a
2
 + R5.a

 
– R6 = 0 

 dengan syarat: ab2 > a > ab 

 Dihitung tulangan A1 dan A2 dengan persamaan: 

A1 = A2 = 
dafy

bafcPa u

..600).600(

).'..85,0/.(

1






 

4) Untuk penampang kolom pada kondisi tulangan tarik menentukan 

menentukan juga dibagi lagi menjadi 3 kondisi yaitu: 

a) Jika ab > ac > at1, maka termasuk kondisi IV: tulangan tarik 

menentukan dengan tulangan tekan kanan sudah leleh dan 

dihitung tulangan A1 dan A2 dengan persamaan: 
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A1 = A2 = 
fydd

aheP

s

cu

).'.(

).2.(.5,0






 

b) Jika at1 > ac > at2, maka termasuk kondisi V: tulangan tarik 

menetukan dengan tulangan tekan kanan belum leleh. Proses 

hitungan dilaksanakan sebagai berikut: 

 Dihitung ap3, R7, R8, dan R9,  dengan persamaan: 

 ap3 = 
fy

ddfy s





600

.1200..2
 

 R7 = ap3 + at1 

 R8 = 2.at1. ds + ac . (2.e – h - ap3) 

 R9 = ac . at1 .(2.ds + 2.e - h) 

 Dihitung nilai a dengan cara coba-coba dengan 

persamaan: 

 a
3 

+ R7.a
2
 + R8.a

 
– R9 = 0 

 dengan syarat: at1 > a > at2 

 Dihitung tulangan A1 dan A2 dengan persamaan: 

A1 = A2 = 
s

u

dafy

bafcPa

..600).600(

).'..85,0/.(

1






 

c) Jika at2 > ac, maka termasuk kondisi VI: tulangan tarik 

menentukan tanpa tulangan tekan. Pada kondisi ini nilai 

eksentrisitas e sangat besar, beban aksial kolom diabaikan 

dan kolom boleh dianggap hanya menahan momen lentur 

saja. Proses hitungan dilaksanakan seperti hitungan 

penulangan balok biasa. 

b. Tulangan Geser Kolom 

1). Hitung kuat geser beton 

a) Untuk daerah sendi plastis 

Vc = 0 

b) Untuk daerah diluar sendi plastis 
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Vc = dbfc ..'.
6

1  

Dimana : 

fc' = mutu beton 

b = lebar kolom 

d = tinggi efektif 

2). Hitung gaya pada baja 

Vs = Vc
Vu




 

Dimana : 

Vu = gaya geser ultimit 

Vc = gaya geser yang ditahan oleh beton 

  = faktor reduksi geser (0,75) 

3). Tentukan jarak sengkang 

s = 
Vs

dfyAv ..
 

Dimana : 

Av = luas tulangan geser 

fy = kuat leleh baja  

d = tinggi efektif 

4). Menghitung spasi maksimum 

s ≤ 
4

d
 

Dimana : 

d = tinggi efektif 

5). Menghitung luas tulangan maksimum 

Avmin = 
fy

Sb

.3

.
 

Dimana : 

b = lebar kolom 
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fy = kuat leleh baja  

S = 1 meter 

6). Menghitung kekuatan gaya geser yang ditahan begel 

Vs = 
s

dfyAv ..
 

Dimana : 

Av = lebar kolom 

fy = kuat leleh baja  

s = jarak sengkang 

d = tinggi efektif 

7). Menghitung kekuatan gaya geser nominal 

Vn = Vs+Vc 

Dimana : 

Vs = gaya geser yang ditahan begel 

Vc = gaya geser yang ditahan beton 

8). Menghitung kekuatan gaya geser rencana 

Vs =  . Vn ≥ Vu 

Dimana : 

Vn = gaya geser nominal 

Vu = gaya geser ultimate 

  = faktor reduksi gesr (0,75) 

 

 

3.7.6. Ukuran Kolom dan Tulangan Memadai 

      Merupakan hasil akhir dari kolom, berupa gambar yang menyatakan 

lokasi dan jumlah tulangan yang dipasang dari kolom yang dihitung 

berdasarkan pendekatan yang telah disebutkan serta memenuhi 

pesyaratan aman.  
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3.7.7. Bagan Alir Perencanaan Kolom 

Ya

Selesai

Tentukan Syarat-Syarat 

Batas

Menentukan Dimensi Balok

Menghitung Beban

Menghitung Momen

Menghitung Tulangan

Ukuran Kolom dan 

Tualangan Memadai

Mulai

Dimensi 

diperbesar

Tidak

Tulangan 

Sengkang 

(begel)

Tulangan 

Longitudinal

 

Gambar 3.20. Bagan Alir Perencanaan Kolom 

 


